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Guide A - Access Tutorial: Employees and Compensation 
 
Purpose: To introduce you to databases and building your first Access database. Within a business, there 
can be a large amount of data that needs to be managed. This data needs to be managed consistently and 
in such a way that it can be easily accessed, updated, and reviewed as needed. Databases allow a company 
to collect data in one central location. 
 
Databases consist of a collection of related objects. Typically, these objects are either tables, queries, forms, 
or reports. The following tutorial gives a brief introduction to each object and some of the characteristics and 
terminology for each. After completing this tutorial, you will have created your first database using Access. 
 
In Access, all objects for a database are stored in one file. This file should end with an .ACCDB extension, 
which is reserved for Access Database files (after version 2007).  

 
Access Tutorial Components: 
 

1.  Starting and Saving your first Database File .................................................................... A-2 
 
2.  Creating Tables in Access ................................................................................................ A-2 

2.1 Enter Field Names and Field Types ........................................................................ A-3 
2.2 Establish a Primary Key or Keys for a Table ........................................................... A-5 
2.3 Save your Table....................................................................................................... A-6 
2.4 Create Two Additional Tables ................................................................................. A-6 
2.5 Create Relationships in Access ............................................................................... A-7 
2.6 Enter Data into your Tables ................................................................................... A-11 
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A.1 Starting and Saving your First Database File 
  

1. Refer to Guide #1 – Starting and Saving Access Files for assistance on creating your first Access 

project file on your own machine or if you do not have Access on your machine how to use Horizon 
(a cloud based solution) to build and complete your homework assignments for Access. 
 

2. Name the database yourLastNameEmpCompensation as in AppleEmpCompensation. Access 
will add the file type of .accdb to your file name. 
 

3. NOTE: Access will ask you for a file name and a location to save the file before you add any data to 
the database.  We recommend that you store the file in your OneDrive Cloud Storage area provided 
by UNCW.  
 
 

A.2.  Creating Tables in Access 
 

Tables generally represent a group of similar items. For example, you may have an Employees table that 
provides data about employees at your company. Tables are comprised of rows and columns. Each 
column within a table represents a single field of data. For example, one field may represent an employee’s 
first name. The collection of fields into a related group is called a record. Each row within a table represents 
a single record. For example, a record may represent one employee. This record will have many fields of 
data about a particular employee – employee id, first name, last name, date hired, etc. Tables will usually 
contain multiple records, each one containing data about individual items (employees in this example case). 
 
In order to be stored correctly, each field of data must have a data type. Table A-1 shows the common data 
types you will be using in your Access databases. 
 
Table A-1: Data Types in Access 

Data type Used for Example data 

Text (also Short Text) Characters or words (letters, numbers, and symbols) Thomas 
X60-MM 

Number: Long Integer Positive and negative whole numbers (with no 
decimal) 

47 
-23390 

Number: Double Positive and negative values with decimal parts -739.4 
9.2454 

Date/Time Valid date and time representations 3/2/2007 
11/28/2003 9:00:00 AM 

Currency Positive and negative values with two decimal places, 
used to represent money (includes $-sign) 

$516,541.12 
($456.51) 

AutoNumber Automated field value that counts starting at 1, each 
new record will have the next integer value (2, 3, 4, 
etc) 

1 
2 

Yes/No Yes or No (also interpreted as True or False) Yes 
No 

 
When creating a table, it is important to choose the correct data type for each field. If all data for a specific 
field will represent money, Currency will be a good choice for a data type for that field. If any of the data for a 
field will require letters or words, Text will be the appropriate data type. 
 
With your Access database file open, notice the menu ribbon bar is displayed at the top of your Access 
window (Figure A-1). This is where many of the options will be displayed that will allow you to create and 
modify objects within the database. You will be using several different tabs within this menu ribbon. 

https://csbapp.uncw.edu/MIS213CasePDF/Guide1-Horizon.pdf
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Figure A-1: The top menu ribbon within Access 
 
Before you are introduced to the other objects within Access, you must choose the names and type of data 
you will be entering.  Think of the name as being a column heading in Excel and the type will describe the 
data to be entered to prevent input errors (i.e. dates, numbers, characters).  
 
Tables are created with several fields and data is entered into rows within the tables. Access contains two 
useful views for tables – Datasheet View and Design View. To start a new table, you should begin in 
Design View. This view allows you to see the field names you will be using and easily assign them an 
appropriate name and data type. 
 
4. Start a new table in Design View by choosing the Create tab from the menu ribbon and selecting the 

Table Design icon in the Tables section of the Create menu ribbon (Figure A-2). 
 

 
Figure A-2: Create a Table in Design View 

 
 
 

A.2.1.  Enter Field Names and Field Types 
 
 

In Design View, each line will represent an individual field. Field names should be descriptive of the data 
that will be stored in the field. The data types are available via a drop down. For this tutorial, you will first 
create a table to store employee data. You will need to anticipate the possible data used for each field 
and determine what data type to use for each field. This table will have the following seven fields: 
- EmployeeID    BranchID 
- FirstName    BaseWeeklyPay 
- LastName    CommissionPercent 
- DateHired 
 
NOTE: As your project will be graded by a computer program, be sure to name the fields EXACTLY as 
indicated in these instructions.  
 
Also note that the field names do not have spaces in them! Do not add data until you build all tables 
and relationships, these instructions are written in the order that you should perform the actions. This is 
important! 

 
5. To add your first field (column) in Design View, type the field name EmployeeID under the Field Name 

Heading and choose Short Text (or Text) from the Data Type drop down. You do not need to add a 
Description. Figure A-3 shows the creation of the EmployeeID field.  Sample EmployeeID’s might be 
0227, or C128 which indicates that the data type should be Short Text and size 4. 
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Figure A-3: Creating a field name called EmployeeID, Short Text and Field Size of 4 
 
 

6. Background for field type and field size decisions: When you select a Data Type for a field, the 
bottom Field Properties panel will display several options. Depending on your data type, you may need 
to set a few options for the field. Text fields should have a Field Size set. The field size determines how 
many characters a field can use. The default is 255.  
For this tutorial, the following decisions have been made: 
 
- EmployeeID will always be 4 characters. (An example EmployeeID is 0227.) 
- FirstName can be restricted to no more than 30 characters. 
- LastName can be restricted to no more than 50 characters. 
- BranchID will always be 5 characters. (An example BranchID is WILNC.) 
 
Keep in mind that even though EmployeeID will be 4 digits, you should make the field ShortText instead 
of Number: Long Integer. The reasoning for this is two-fold. First, Text will store any leading zeros that 
may occur. For example, 0053 will be stored as 4 characters in a Text field, while the 00 will be dropped 
and only 53 will be stored in a Number: Long Integer field. Second, Number types should really only be 
used if arithmetic will be performed on the field values. You will never add or multiply EmployeeID 
values, so there is no need to store these as data type Number. Calculations will be discussed more in 
depth when queries are introduced. 

 
7. Continue the setup for the fields of the table Employees using Figure A-4 as a guide. Don’t forget to set 

appropriate field sizes for text fields as shown above. Field sizes only have to be set for text fields.  
Several of these fields require letters to represent the data; these should be of type Text. These fields 
are EmployeeID, FirstName, LastName, and BranchID. 
 

 
Figure A-4: Setup for all fields in table Employees 
 
As a final note on data types, when setting up a field of data type Number, pay attention to the Field 
Properties at the bottom of your screen. Depending on your desired data, you may need to configure the 
properties. The default size for a Number is Long Integer. Remember that integers are WHOLE numbers 
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and CANNOT contain a decimal part. For CommissionPercent in this setup, Double representation 
of the percentage is needed. Figure A-5 shows the Field Properties for CommissionPercent. 
 

 
Figure A-5: Setup for field CommissionPercent (table Employees) 
 
 

A.2.2.  Establish a Primary Key or Keys for a Table 
 
Before saving your table, you need to designate a primary key. A primary key is a field in the table whose 
value can distinguish a record from all other records. Primary keys must be UNIQUE. No two records can 
share the same primary key value. Primary keys also cannot be NULL (blank or empty). Primary key fields 
MUST contain a value before the record can be created.  Some tables will have more than one Primary Key 
field.  Think of a table that tracks club dues, it might have a field for the club member number and the date 
paid as members might make more than one payment per semester. 
 
Looking at the table Employees, every field should be analyzed to determine the primary key. Immediately, 
some fields can be ruled out as NOT unique. DateHired, BranchID, BaseWeeklyPay, and 
CommissionPercent will most likely NOT be unique. Different employees can share these details. These 
cannot be the primary key. FirstName will most likely not be unique as well and should not be the primary 
key. Many people make the mistake of creating fields such as LastName as the primary key. This is not a 
good idea because once a value is used for a record, it cannot be reused. When you are entering data for 
employees, two employees may have the same last name – Smith for example. To be a primary key, the 
value MUST BE UNIQUE for every record. LastName is not a good primary key candidate. Sometimes 
selecting a primary key can require a bit of forethought – you must anticipate possible future data that “could” 
be used throughout the lifetime of a database. 
 
8. In the table Employees that you just created, Employee ID is the only field that is guaranteed to be 

unique and not null. This will be the primary key.  
 
Create a primary key on the field EmployeeID in the table Employees. To do this, select the small gray 
square to the left of the field name EmployeeID. This will highlight this field. Now click the Design tab in 
the menu ribbon. Select the Primary Key button in the Tools section of the Design menu ribbon. A small 
key will be placed next to the highlighted field. Figure A-6 shows this process. 

 

 
Figure A-6: Setting a primary key within a table 
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Good to know: Some tables require more than one field as a primary key. This is known as a compound 
key. With a compound key, the combination of the data in all selected fields must be unique and not null. To 
create a compound key, you must select all fields of interest. To do this, you would first click the gray square 
to left of the first field. Then – on your keyboard – press and hold the CTRL key and click the gray square to 
the left of the second field. You can continue this process until all desired fields are highlighted. Then you 
can select the Primary Key button in the Design menu ribbon just as above. This tutorial does not require any 
compound keys, but you may see them in future cases and assignments. 
 
 

A.2.3.  Save your Table 
 

9. After setting up your fields and designating a primary key, you can now save your table. 

Save your table by clicking the Save icon  located in the extreme top left of your screen. You should 
get a popup asking for the name of the table. The table name should be descriptive of the types of record 
within the table. This is a table where every record represents an employee, so name it Employees. 
Figure A-7 shows the save dialog you will see. 

 

 
 
Figure A-7: Save dialog for table Employees 

 
After saving the table, notice the left panel of Access that now shows Employees listed under the 
heading Tables. This panel lists all Access Objects (tables, queries, forms, and reports). As you create 
new objects, they become visible in this panel. Looking back to the table Design View on the right, you 
can right-click the Employees tab and choose Close to close the table. You have successfully created 
your first table. 

 
 

2.4.  Create Two Additional Tables (Branches, Sales) 
 
 
10. Create a table named Branches with the following 3 fields: 

- BranchID will be 5 characters. 
- City should be no more than 100 characters. 
- State should be 2 characters. 

 
You should be able to determine the appropriate data types for each field given. Remember to set the 
appropriate Field Properties when needed. In addition, each table needs to have a primary key. You 
should be able to determine which field should be the primary key. Use Section 2.2 as a guide. 
 

11. Using Figure A-8 as a guide, create a table named Sales with the following 4 fields: 
- SaleID should be automatically generated. 
- EmployeeID will be 4 characters. 
- DateOfSale (HINT: This is a date.) 
- Amount (HINT: This is money.) 
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Figure A-8 Setup for tables: Branches and Sales, (You need to select a Primary Key in each table) 
 

 
Important: While creating your tables, notice that some fields are common between different tables. For 
example, the field BranchID exists in both tables Branches and Employees. This is a very important fact to 
notice. The field BranchID in the table Branches is a primary key, which means that it uniquely identifies a 
specific record. Inside the table Employees, however, the field BranchID is known as a foreign key. This 
means the field value of BranchID in a record in the table Employees helps to identify all of the data of one 
particular record in the table Branches (identified by the BranchID). For now, take note of this connection and 
make sure that the common fields in different tables have the same data type and size. BranchID should be 
of type Text and Field Size 5 in both tables: Branches and Employees. The same is true for the EmployeeID 
of tables Employees and Sales: both should be of type Text and Field Size 4. This information is essential in 
the next section when creating relationships. 
 
After saving your tables, you should notice that you now have three tables listed in the left panel under 
Tables. These should be your tables Employees, Branches, and Sales. If you need to make changes to the 
setup of these tables, you can right-click the table you wish to modify and choose Design View. Figure A-9 
shows this process. 
 

 
 
Figure A-9: Listing of all objects in your Database and to re-enter Design View 

 
 

A.2.5.  Create Relationships in Access 
 

NOTE: It is important to build relationships between your tables BEFORE entering the data. This will 
reduce the number of errors you will see later on during your work. If you double-click the table, it will 
open in Datasheet View. You have not been introduced to Datasheet View yet – it will be used for data 
entry. Again, you should not enter any data into your tables until you have created relationships. 

 
12. Before moving on, you must close all open tables. If you have tables open, Click the X next to the Table 

Name in the Tab or right-click each table tab and select Close (depends on your version of Access). 
 

13. Once you have built all three tables, you can now tell Access how to “share” data. Remember the 
concept of a foreign key. When a foreign key is provided, we can then “share” specific data between 



Access A - 8 

©2022 – Congdon School of Supply Chain, Business Analytics and Information Systems, Cameron School of 
Business and University of North Carolina Wilmington 

tables. This concept is known as a relationship. Relationships are created on common fields – fields 
that represent the same type of data. A relationship will exist on a field that is a primary key in one table 
and a foreign key in another table. To create the relationships between tables, you will create a 
relationship diagram. This diagram shows which tables are connected and on what fields. A 
relationship diagram is a graphical way to illustrate the relationships within a database. 

 
Start building a relationship diagram in your database. To do this, select the Database Tools menu 
ribbon and click the Relationships icon in the Relationships section (Figure A-10). 

 
 

 
 
Figure A-10: How to open the relationship diagram to build relationships 

 
14. After clicking the Relationships icon, you should see a popup labeled Show Table (Figure A-11). If you 

do not see this popup, click the Show Table icon in the Design menu ribbon. This popup lists all of the 
tables you have created (Branches, Employees, and Sales). 

 
Add all three tables to your diagram. Do so for each table by first clicking the table name to highlight it 
and then clicking the Add button. You may also double-click the table name to automatically add it to the 
diagram. As you add a table, you will see it in the background relationship diagram. If needed, move the 
popup in order to see the tables that you have already added. 
 

 
 
Figure A-11: Table dialog for relationships 
Once you have added all three tables, click Close to view the diagram. Your screen should look like 
Figure A-12. 
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Figure A-12: Relationship diagram after adding all three tables 

 
You should notice that the relationship diagram displays the tables and the field names you have created. In 
addition, you can see which fields you have selected as the primary keys. You can resize the tables 
individually in the diagram if you want to see more or less. 
 
15. To create relationships, you need to determine which fields are in common between two tables. For 

example, the field BranchID exists in both the table Branches and the table Employees. This is a field 
where a relationship should exist. A relationship will exist on a field that is a primary key in one table and 
a foreign key in another table. If you create a relationship on the field BranchID, then the table Branches 
can “share” data with the table Employees via this common field. 

 
Create a relationship between the common field BranchID in the table Branches and in the table 
Employees. To do this, click and hold your mouse button above BranchID in the table Branches. Drag 
and release the mouse button on top of the field BranchID field in the table Employees. Note that it is 
very important to connect the COMMON fields. You should get a popup with settings like Figure A-13. 
 

 
 
Figure A-13: Relationship settings between tables Branches and Employees 
 
Notice that there are two columns in the settings popup. Verify that the two tables of interest (Branches 
and Employees) are listed. In addition, make sure that the Field selected in the drop downs is the 
common field (BranchID). If the data does not match what you expect, you may Cancel the popup and 
try again or manually change the drop down selections. From here, you also want to select Enforce 
Referential Integrity. Referential integrity means that a record must exist in the primary table (left 
column of the popup) BEFORE it can be used in the secondary table (right column of the popup). For 
this example, a record with a particular BranchID value (e.g., WILNC) must be created in the table 

✓ 



Access A - 10 

©2022 – Congdon School of Supply Chain, Business Analytics and Information Systems, Cameron School of 
Business and University of North Carolina Wilmington 

Branches BEFORE that BranchID can be used in a record in the table Employees. All of your 
relationships should enforce referential integrity because this will prevent typos and other problems 
when entering data into the tables. 
 
Also take note of the Relationship Type at the bottom of the popup. Based on your table setup, Access 
will automatically determine the relationship type for your relationships. This will be One-To-Many, One-
To-One, or Many-To-Many. 
 
NOTE: While creating relationships, you may encounter the popup shown in Figure A-14. If you get this 
error, Cancel all popups and go back to step 12 to close all open tables. You cannot create relationships 
unless all tables are closed first. 

 

 
 
Figure A-14: Error received if tables are open when attempting to create relationships. 

 
16. Once you have checked your data and selected Enforce Referential Integrity, you can click Create to 

create the relationship. Your diagram should now resemble Figure A-15. 
 

 
Figure A-15: Relationship diagram with relationship between tables Branches and Employees 
 
Notice the line drawn between the tables Branches and Employees. The line should begin and end on 
the BranchID fields. Also notice the symbols used. These represent the Relationship Type for this 
specific relationship. If you do not see the symbols on your lines, go back to make sure you have 
checked Enforce Referential Integrity. To edit a relationship, right-click on the line created. It can be hard 
to get just on the line with your mouse cursor. Once you have selected the relationship, you see two 
options: Edit Relationship and Delete. Figure A-16 shows the proper options for altering a relationship 
that has already been created. To remove the selected relationship, chose Delete. To see the settings 
popup again (Figure A-13), choose Edit Relationship. 
 

 
 
Figure A-16: Options displayed after right-clicking on an existing relationship 
 

17. Create another relationship between the tables Employees and Sales. Remember to use the common 
field and to select Enforce Referential Integrity in the setup. Your finalized relationship diagram for this 
tutorial should look like Figure A-17. 
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Figure A-17: Relationship diagram for this database 
 

18. To finish, click the Close button in the Design menu ribbon. You should be prompted to save. Choose 
Yes. Only one relationship diagram can be created for a database – you do not have to name your 
relationship diagram. See Figure A-18. 
 

 
 

Figure A-18: Saving and closing the relationship diagram 
 
 

A.2.6.  Enter Data into your Tables 
 
19. Remember that there are two useful views within Access for viewing your tables. For creating tables, 

Design View is used. Once a table has been created, you will generally want to view your table using 
Datasheet View. This is the default view when opening a table. If you locate a table on the left panel of 
Access and double-click the name, the table will open in Datasheet View. Open the table Branches in 
Datasheet View (Figure A-19). 

 
Notice that the field names you created are now listed as column headings in Datasheet View. 
Remember, each row within a table represents one record. In the table Branches, each row (=record) is 
designed to contain values for the fields BranchID, City, and State of one specific branch. 

 

 
Figure A-19 Table Branches in Datasheet View 



Access A - 12 

©2022 – Congdon School of Supply Chain, Business Analytics and Information Systems, Cameron School of 
Business and University of North Carolina Wilmington 

Begin your data entry by typing the field values displayed in Figure A-20 for table Branches. To move 
between the different fields/columns, you can use the Tab key on your keyboard. Once you have reached 
the end of a record, you will be automatically moved to a new record.  
 

NOTE: Changes made to the data in Datasheet View are AUTOMATICALLY saved once you move to 
another record. You do not have to continually click the Save icon. As long as the asterisk (*) appears to 
the left of the record, the record is in Edit mode. If you make a mistake in Edit mode, you can press the 
ESC key on your keyboard to cancel the current edits. 

 

 
Figure A-20: Data for the table Branches 

 
20. Enter the data for the table Employees as shown in Figure A-21. Note that BranchID is a foreign key field 

in the table Employees that is related with the primary key field BranchID in the table Branches. Since 
you created the records in the table Branches first (in the previous step), you can now refer to them by 
entering appropriate values into the field BranchID in the table Employees. During data entry, you may 
notice that you can only enter values for BranchID in the table Employees that also exist in the table 
Branches. Any typos or unrecognized field values will trigger an error message and need to be corrected 
before you can move on to the next record. This is a direct result of checking Enforcing Referential 
Integrity during the relationship diagram stepup (Figure A-15). 

 
While entering data, notice also how the data type selections you made while creating your table designs 
come into play. EmployeeID will only allow you to enter 4 characters. DateHired is formatted as a date 
(2/5/2011), BaseWeeklyPay is formatted as Currency, BranchID will only allow you to enter 5 characters, 
and CommissionPercent allows decimal places. This is why it was important to spend time learning the 
different data types and their specific limitations and uses. 
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Figure A-21: Data for the table Employees  
 
21. Finally, enter the data for the table Sales as shown in Figure A-22. Notice that you do not have to (and 

actually cannot) enter any values into the field SaleID. The data type of this field is set to be 
AutoNumber, which automatically increments field values starting with 1. If you make an error and delete 
a record, AutoNumber may skip a number in the sequence, which you can do nothing about. So, please 
do not worry if the values in your field SaleID differ from Figure A-22. Everything else should match, 
however. 

 

 
Figure A-22: Data for the table Sales (values in the field SaleID are auto generated by the system and 
may vary) 
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A.3. Basic Queries 
 

 
Data stored in tables is often relatively useless on its own. The power of a database lies in its ability to share 
this data (through relationships), and answer questions or show information based on the data. The way to 
answer a question with a database is by creating a query (pronounced “kweer-ee”). A query is basically a 
repeated question: once a query is set up, it can be executed over and over. Each execution collects and 
manipulates the most recent data from the tables in the database and supplies a set of result records. 
 
From the tables Branches, Employees, and Sales that you have already created, possible questions a 
company may be interested are: 
- Which employees are at the Wilmington branch? 
- Who in the company has worked here for over 10 years? 
- Which employees make a commission rate above 3%? 
- What are the total overall sales for each branch? 
- How many sales are made each day? 
- What are the full details of a specific sale? 
 
As you can see, the answers to these questions may be different today than they will be tomorrow, next 
week, or next month. Every time you run a query, it supplies you with the most recent answers. 
 
Queries are created by using existing fields and tables. In a query you can reorganize the data, perform 
arithmetic calculations, and determine totals, such as Sum, Average, etc. In Access, you can build queries 
with an interactive system known as query by example (QBE). QBE makes it easy to manipulate existing 
tables and extract the data needed to answer particular questions. 
 
22. Like for tables, Access also contains two useful views for queries – Datasheet View and Design View. 

To start a new query, you should begin in Design View. This view allows easy manipulation of existing 
tables and fields. Design View provides the QBE method to build queries. 

 
Start a new query by choosing the Create tab from the menu ribbon and selecting the Query Design 
button within the Queries section of the Create menu ribbon (Figure A-23). 

 

 
 
Figure A-23: How to create a new query in Design View 

 
Once you have created the query, you should immediately see a prompt labeled Show Table. This is the 
same prompt that you used when creating your relationships (Figure A-11). The prompt should list all 
tables within the database (Branches, Employees, and Sales). Unlike for the relationships, however, you 
SHOULD NOT add all tables for every query. Before you can determine which tables to use, you must 
think about what data you need. In the next part of this tutorial, we present you with a series of example 
queries to help you get familiar with the query Design View in Access. 
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A.3.1. SelectEmployees 
 
 
Query -SelectEmployees: What are the names and employee IDs of all employees? 
 
23. To answer this question, we will create a query that displays the values for EmployeeID, LastName, and 

FirstName of all employees. This data should be sorted in alphabetical order by last name. Keep reading 
for details on how to create this query. 
 
This is a simple select query. In a simple select query, you are not manipulating data; you are just 
displaying the data in a specific order or view. 

 
The first step in creating a query is to determine what tables are needed to answer the question. We note 
that the fields LastName and FirstName only appear in the table Employees, so we will definitely need 
the table Employees for the query. Add the table Employees using the Show Table popup. 

 
EmployeeID is a field in both tables Employees and Branches. A good rule when adding tables to the 
query designer is to include the FEWEST tables that still provide all the fields needed. We note that all 3 
fields needed for this query are available in JUST the one table Employees. As a result, we do not need 
to add the other tables Branches or Sales to the query, and after adding the Employees table to the 
query, you can close the Show Table popup. You should see a screen similar to Figure A-24. This is 
where you will manipulate your query fields. 

 

 
 
 

Figure A-24: Design View for first query SelectEmployees with table Employees added 
 
24. The next step is to add the desired fields to your query. In the top half of the Design View, find the fields 

you are interested in and double-click them. This will add each field – in order – to the bottom panel. This 
bottom panel determines what data will be output when this query is executed. 
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Add EmployeeID, LastName, and FirstName to the query to be displayed. Each field should display in its 
own column in the bottom panel of the Design View. When you are finished, your bottom panel will look 
like Figure A-25. 

 

 
 
Figure A-25: Design View for first query SelectEmployees after adding desired fields 
 
 
Only the fields displayed at the bottom of the Design View can be displayed when the query is executed. 
If you wish to hide a selected field, please uncheck the Show box for that particular field. In addition, you 
can use the drop down available to change Field and Table selections in the bottom panel. 
 

25. During execution, query results are sorted by default in ascending order (smaller to larger) from left to 
right. This means our query will be sorted ascending by EmployeeID (low numbers to high numbers). For 
this query, however, we want to sort by LastName and we want the sort to be alphabetical. To change 
the default sort, we use the Sort line in the Design View. Alphabetical (A-Z) is considered ascending 
order (A is LOWER than Z). 

 
Change the sort for LastName to be Ascending. Leave the other sort values blank. Your completed 
Design should look like Figure A-26. 
 

 
 

Figure A-26: Design View for first query SelectEmployees after adding sort 
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View the results that this query will display. To do so, click the Run icon in the Results section of the 
Design menu ribbon. This is shown in Figure A-27. Once you RUN the Query, you should see the results 
shown in Figure A-28. 
 

 

 
 
Figure A-27: Use the Run icon to execute a query 
 
 

 
Figure A-28: Results of query SelectEmployees 
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26. Save your query now as SelectEmployees (note: no space).. To save, use the Save icon in the 
extreme top left of Access or right-click the Query1 tab and choose Save. You will see a prompt asking 
for a Query name. Type SelectEmployees (Figure A-29). After saving, you should see SelectEmployees 
in the left panel under the heading Queries. When saved, your queries will be listed in this objects panel. 
You can double-click existing queries to execute them. 

 

 
 
Figure A-29: Save dialog for query SelectEmployees 

 
 

A.3.2. SelectWilNC 
 
 

Query - SelectWilNC: Which employees work in the Wilmington, NC branch? 
 
27. Create a query that displays the values in the fields EmployeeID, FirstName, LastName, BranchID, City, 

and State of all employees at the Wilmington, NC branch (WILNC). Keep reading for details on how to 
create this query. 

 
This is a criteria select query. A simple select query (e.g., SelectEmployees) displays all records for the 
tables selected. A criteria select query only displays specific records. The records displayed must match 
given criteria on certain fields. For this query, you will show values ONLY for employees at the 
Wilmington branch. To accomplish this, you can set up the query to select only the records where 
WILNC is listed as the value in the BranchID field. 

 
Create a new query in Design Mode. Determine which tables are required and add them to this query. 

 
EmployeeID, FirstName, and LastName exist as field names in the table Employees. BranchID is a field 
in both tables Employees and Branches. City and State are fields only contained in the table Branches. 
So, this query requires the two tables Employees and Branches. Once you have added these two tables 
through the Show Table popup and have closed the popup, you see a screen similar to Figure A-30. If 
you have set up your relationships as described earlier in this tutorial, you can see a line connecting the 
field BranchID in the table Employees with the field BranchID in the table Branches.  
 

 
Figure A-30: Design View for second query SelectWilNC after adding required tables 
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28. Add the required fields from the tables to the query Design View. Remember, you can double-click each 
field to do this. You should select the fields in the order you wish them to be displayed. Choose 
EmployeeID, FirstName, LastName, BranchID (doesn’t matter which one, but typically you should 
choose the “root” table: Branches), City, and State. Your bottom panel should look like Figure A-31. 

 

 
 
Figure A-31: Design View for second query SelectWilNC after adding required fields 

 
 

To create a criteria select query, you utilize the Criteria option in the bottom panel of the query Design 
View. Typically, you use a comparison for your criteria. Comparisons can come in many different forms. 
The simplest forms are equal, not equal, greater than, less than, greater than or equal to, or less than or 
equal to. The symbols used for each of these comparisons are shown in Table A-2. If no comparison 
symbol is used, equality is assumed. 
 
NOTE: When doing comparisons with Text (i.e., characters like letters), you should surround the phrase 
with quotes (Example: “Bob”). When using Dates, you should surround the date with hash tags 
(Example: #1/21/2014#). 

 

Table A-2: Symbols used for comparisons in Access 

Comparison Symbol Example Usage 

Equal to = = 47 
= “Bob” 
= Yes 
= #1/21/2004# 

Not equal to <> <> -1 
<> “Blue” 
<> No 
<> #12/31/2012# 

Greater than 
 
After (with dates) 

> > 0 
> 50000 
> #1/1/2012# 

Less than 
 
Before (with dates) 

< < 0 
< 100 
< #1/1/2000# 

Greater than or equal to 
 
On or after (with dates) 

>= >= 0 
>= 500 
>= #1/1/2012# 

Less than or equal to 
 
On or before (with dates) 

<= <= 0 
<= 250000 
<= #12/31/1999# 
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29. Add criteria under the field BranchID to require it to be equal to WILNC. Your Design View will look like 
Figure A-32. 

 

 
 
Figure A-32: Design View for second query SelectWilNC after adding criteria 

 
30. Run your query. Your results should match Figure A-33. Save this query as SelectWilNC. 
 

 
Figure A-33: Results of query SelectWilNC 

 

A.3.3. CalcFieldCommission 
 

Query - CalcFieldCommission: What is the commission value for each sale? 

 
Sometimes, the questions you wish to answer require more than just reading data values from tables. For 
example, in our case, employees are paid a commission for each sale. The dollar amount of each 
commission payment depends on the commission percent that each employee is entitled to and the amount 
of the sale (in $). Yet, there is no field in any of our tables that shows the dollar amount of each commission 
payment. So, in order to answer the question about what commission is paid out for each sale we can 
manipulate the data by defining a new field as part of a query1. In other words, we use the values in one or 
more data fields that do exist in the tables (namely commission percent and amount of sale) to determine the 
values of a new field (namely the commission value in $ for each sale). The new field is called a calculated 
field; the query that includes it is called a query with a calculated field or calculated query. 
 
To calculate new field values in a query, you can perform various arithmetic operations on existing field 
values. The simplest arithmetic operations are add, subtract, multiply, and divide. Table A-3 shows the 
operation symbols that you can use to construct a formula that calculates the needed values for a query.  
 
Please, note that the standard order of operations used in mathematics principles applies. Therefore, you 
may need to use parenthesis to ensure that you build a formula correctly. 
 
 
 
 

 
1 Manipulation in the context of a calculated field does NOT mean that we change any data values in the 
tables in our database. It merely refers to the data values that we use and display in our QUERIES and that 
may now be different from the data values that are in the tables. 
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Table A-3: Symbols used for simple arithmetic operations in Access 

Operation Symbol Example Usage 

Add + [BaseWeeklyPay] + 500 

Subtract - [HourlyPay] - 1.25 

Multiply * [CommissionPercent] * [Amount] 

Divide / [AnnualSalary] / 52 

 
Operations can be performed with numbers or with field references. Notice in the examples that if you are 
using a field reference in a formula, the field name should be surrounded by square brackets (e.g., 
[BaseWeeklyPay]) but the numeric value to add or multiply is NOT in brackets. In addition, the field 
name used in the calculation MUST match the spelling in the table. If you misspell a field reference, Access 
will not be able to find the field you need and produce an error message when running the query. 
 
 
31. Create a query that shows SaleID, Amount, and Commission for all sales records. Commission should 

be a calculated field: it is calculated by multiplying the CommissionPercent of the employee who made 
the sale by the Amount of the sale. Sort the results in Ascending order by SaleID. Keep reading for 
details on how to create this query. 

 
To begin, let’s determine the formula for the calculation. To calculate the commission value, we take the 
value CommissionPercent in the table Employees and multiply it by the value Amount in the table Sales. 
So, we already know that we need those two tables. In addition, SaleID and Amount are both in the table 
Sales. It turns out that for this query we will not need the table Branches, just the tables Employees and 
Sales. 

 
Create a new query in Design Mode. Add the two required tables for this query. 

 
32. Access requires you to type the formula for the calculated field manually, which we will do shortly. For 

now, add the first two NON-calculated fields as you normally would by double-clicking the field names in 
the table. You can also add the sorting as required. To create more room for the upcoming calculated 
field, please expand the third column. Your Design View should look like Figure A-34. 

 

 

Figure A-34: Design View for query CalcFieldCommission after adding required tables, fields, and 
sorting 
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33. The formula for the calculated query is [CommissionPercent] * [Amount]. Remember: Field Names 
should be surrounded by square brackets2 and MUST be spelled correctly. 
 
Manually type the formula for Commission into the third column of the Design View. After typing the 
formula, press the Enter key on your keyboard. 
You should notice that the column is now filled with the following:  
 

Expr1: [CommissionPercent] * [Amount] 

Every column must have a name. Since this field is not recognized as an already existing field name, it 
must be given a name. If you do not designate a name to your field, Access will assign a random name, 
e.g., Expr1. 

 
34. Rename the column that you created to read Commission. To do this, replace Expr1: with Commission. 

You MUST keep the colon in order for the renaming to work correctly. Your Design View should look 
like Figure A-35. 

 

 

Figure A-35: Design View for third query CalcFieldCommission after adding the calculated field 

and renaming it 

35. Figure A-36 shows part of the query results after you click the Run button. Notice that the field 
Commission is not yet formatted as currency.  

 

 

Figure A-36: Results from running query CalcFieldCommission before formatting Commission 

field 

To format the query field Commission, go back to Design View and then alter the field properties as 
follows: Right click on the column you wish to format and select Properties. You should notice a panel 
named Property Sheet on the right of your screen (Figure A-37). Under the General tab, locate the 
Format option and choose Currency from the drop down. This will add the $ symbol and 2 decimal 

places to the selected field. This must be done in Design View. 

 
2 Square brackets are mandatory for field names that contain blanks (spaces). 
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Figure A-37: Property Sheet panel for query Design View 

After changing the Field Properties, you can leave the Property Sheet panel open or you may close it by 
clicking the small X in the top right corner of the panel. 
 

36. Run your query. Your results should match Figure A-38. Save this query as CalcFieldCommission. 
 

 
 

Figure A-38: Results of query CalcFieldCommission 
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A.3.4. TotalsBranchSales 
 

Query - TotalsBranchSales: What are the total sales for each branch? 
 

Some queries require more than a calculation for each record. Many questions related to data within a 
database require some type of aggregation. In other words, it may be necessary to summarize the data from 
multiple records into a group. This type of query is known as a totals query. The common functions of totals 
queries include: Sum, Average, Minimum, Maximum, and Count. 
 
You may be able to identify the need for a totals query by the phrasing of the question you are trying to 
answer. Table A-4 gives examples of common phrases for each type of totals query. Please, note that totals 
queries group a collection of similar records together and display one total or summary value for the entire 
group, rather than providing individual values for each record. 
 
Table A-4: Common phrases for totals queries 

 
Function Example Phrases 

Sum What is the total…? 
How much…? 

Average What is the average…? 
On average, how much…? 

Minimum What is the least…? 
Identify the lowest… 

Maximum What is the highest…? 
Identify the most… 

Count How many…? 
Determine the number of… 

37. Create a query that shows BranchID, City, State, and TotalSales. TotalSales will need to be a summary 
field based on the collection of sales records at each branch. In order to answer this question, you will 
need to create a totals query. Keep reading for details on how to create this query. 
 
To determine TotalSales, you will want to add together the Amount value of each sale at a particular 
branch. You need to group records by their branch in order to perform this accumulation. To begin, 
create a new query in Design Mode. 
 
First, you must determine what tables are required for the query: BranchID, City, and State are in the 
table Branches; Amount (to be used for TotalSales) is in the table Sales. When you add these two 
tables, you should notice that they are NOT connected, meaning that there are no common fields or 
defined relationships. So, before setting up the query details, these tables need to be linked in some 
way: Remember that each record in the table Sales includes an EmployeeID. Also, each record in the 
table Employees includes a BranchID. This means that if we add the Employees table, there will be a link 
from Branches to Sales (via Employees). You may want to reorder your tables in the Design View to 
better see the flow of data. After adding all tables, your Design View should look like Figure A-39. 
 

 
Figure A-39: Design View for query TotalsBranchSales after adding required tables 
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NOTE: If you have already closed the Show Table popup and need to add additional tables, you can 
click the Show Table icon in the Query Setup section of the Design menu ribbon. 
 

38. Add the fields required for the query to the Design View by double-clicking them: include BranchID, City, 
State, and Amount. Your Design View should look like Figure A-40. Next you will be modifying the query 
to allow totals, which will alter the Amount field. 
 

 
 
Figure A-40: Design View for query TotalsBranchSales  after adding required fields 
 
 

39. Before you can get the total of the sales amounts for each branch, you need to provide some grouping of 
records. To designate this query as a totals query, click the Totals icon in the Show/Hide section of the 
Design menu ribbon (Figure A-41). 

 

 
 
Figure A-41: The Totals icon in the Design menu ribbon 

 
Notice that you have a new line available in the bottom panel of the Design View. This line is labeled 
Total. The new Query Design panel is shown in Figure A-42. 
 

 
 
Figure A-42: Design View for query TotalsBranchSales  after designating the query as a totals 
query 

 
 

Notice that every field chosen in the Design View now says Group By as the selection for the Total line. 
The power of the totals query comes from the ability to group based on records with the same value for 
designated fields. For this query, you will want to group all sales that have the same BranchID, City, and 
State, so these 3 fields should remain as Group By for the Total selection. 
 
The field that is “different” is Amount where we want to obtain the sum of all the sales. Figure A-43 
shows the drop down selections for the Total line of the query designer. To get the Total Sales, you need 
to ADD all of the Amounts of the sales. This is a Sum. 
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Figure A-43: Selections provided for Total option in Design View 

 
40. Create a Sum on the field Amount by choosing Sum from the drop down that is provided in the Total-row. 

Your Design View should look like Figure A-44. 
 

 
 
Figure A-44: Design View for fourth query TotalsBranchSales  after setting the appropriate Total 
selection for the field Amount 

 
41. If you run the query as is, notice the column headings (Figure A-45). Like with calculated field names, 

Access gives totals fields a new name. For the fourth field here, Access has named it SumOfAmount. 
Instead of this, we want to rename the field to TotalSales. 

 

 
 

Figure A-45: Field names before renaming the Totals-field 
 
 
To rename a field, follow the same procedure you did in the prior query, place the name you desire, 
followed by a : (colon) and leave the field name that already exists in the Design View: 
 
 DesiredName: [FieldName] 
 
There are several key notes about this format. 

- The desired column name comes first. In this query, our desired name is TotalSales. 
- After the desired field name, you MUST include a colon (:). Without this colon, Access will not 

know that you want to rename the field. 
- All previously existing field names MUST be spelled exactly the same way as in the tables. A 

misspelling will result in error messages during query execution. 
 
In Design View, add a column heading in the fourth field of TotalSales. You may need to extend the 
width of the column to see its entire contents. When finished, your Design View should look like Figure 
A-46 
 



Access A - 27 

©2022 – Congdon School of Supply Chain, Business Analytics and Information Systems, Cameron School of 
Business and University of North Carolina Wilmington 

 
 
Figure A-46: Design View for fourth query TotalsBranchSales  after renaming fourth column 

 
42. Run your query. Your results should match Figure A-47. Save this query as TotalsBranchSales . 
 

 
 

Figure A-47: Results of query TotalsBranchSales  
 
 

A.3.5. ParameterSalesOnDate 
 

Query - ParameterSalesOnDate: What are the details for sales that occurred on - mm/dd/yyyy-? 
 
If the answer to a question depends on input provided by the user who runs the query, you can create a 
parameter query. A parameter query allows new data to be included in the query when it is executed. For 
example, you may want to know the details of all sales on a specific date. Instead of creating a query for 
every conceivable date up-front, you can create a parameter query that allows looking up sales records “on 
the fly”. 
 
43. Create a new query in Design Mode. Add the required tables for this query. Also select the fields as 

shown. Your Design View should look like Figure A-48. 
 

 
 
Figure A-48: Design View for fifth query ParameterSalesOnDate after adding required fields 
 
44. If you were to run the query at this point, you would see ALL sales records. You need to restrict the 

DateOfSale to a specific date. If this value were known, you could create a criteria select query that used 
the value given. Since the value will be given DURING execution of the query, you must provide a 
parameter. This will pause the query during execution and wait for the user to enter in a value. Keep 
reading for details on how to create a parameter. 
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Parameters are created using square brackets in the Criteria line of the Design View. This will signal 
Access to provide a popup prompt to the user with a message that you supply. The format of your 
parameter is as follows: 
 =[Message user will see during execution] 
 
Modify the message within the square brackets to fit the query that you are building. Remember, this 
parameter should be placed in the Criteria line of the field that you want to restrict. Also, keep in 
mind that parameters – like any criteria – can use any of the comparison symbols listed in Table A-2. In 
this case, we use equal to. Also remember that if no comparison symbol is used, equality is assumed. 
 
NOTE: Since parameters are formed with square brackets AND field references are also formed with 
square brackets, you CANNOT use a parameter that has a message that is the same as an existing field 
name. It’s good practice to format your parameter message as a question. At minimum, you could just 
add a question mark to an existing field name for your parameter. Example: =[DateOfSale?]. While this 
will work, a better parameter would be =[What date?]. 
 
To facilitate grading, DO NOT use the Parameter Icon in the Ribbon Bar at the top of Access 
(Figure A-49). Create your parameters by adding the Criteria Row like Figure A-50. 
 

 
 
Figure A-49: Please do not use the Parameter Icon to enter your question for the user (parameter) 
 
Add a parameter to restrict the records displayed to a specific DateOfSale. To do this, enter criteria for 
DateOfSale to prompt the user for a date. Your Design View will look like Figure A-50. 

 

 
Figure A-50: Design View for fifth query ParameterSalesOnDate after adding parameter 

 
 
Every time you run this query, you will notice a prompt that displays the message you typed in your 
parameter (Figure A-51). The results of the query depend on the date that is supplied by the user. 
 

 
 
Figure A-51: Prompt displayed when executing query ParameterSalesOnDate 
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45. Run your query. If you type in 4/2/2021 when prompted for the date, your results should match Figure A-
52. If you type in 4/4/2021 when prompted for the date, your results should match Figure A-53. Save this 
query as ParameterSalesOnDate. NOTE: This is ONE query – NOT two separate queries! The output 
depends on the value given for the parameter  which changes each time the query is executed. 

 

 
 

Figure A-52: Results of fifth query ParameterSalesOnDate (when given 4/2/2021 as the parameter 
value) 

 
 

 
 

Figure A-53: Results of fifth query ParameterSalesOnDate (when given 4/4/2021 as the parameter 
value) 
 

 
 
Please check with your instructor, as for most classes, this ends this project and now you should upload to 
Entropy -- .  Please see https://csbapp.uncw.edu/MIS213CasePDF/Guide1-Horizon.pdf - the guide for 
uploading files, see page 1-9 for those on your own PC, or for Horizon users, see page 1-10.  
 
In addition, please see page 1-13 on how to make a copy of this homework and save it to your CLOUD – 
One Drive area. This is important as periodically ITS clears all files in Horizon’s document/download folders. 
 
  

https://csbapp.uncw.edu/MIS213CasePDF/Guide1-Horizon.pdf
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A.4.  Advanced Queries 
 
For the Advanced Queries you will not be shown the Design View Screen, but you will see the results of the 
queries. This will help you to determine which table(s) you will need to pull the appropriate fields to display.  
Only add those tables that you need to retrieve a field or to provide a relationship needed between your 
table(s). 
 

A.4.1. SelectSales 
 

Query - SelectSales: What are the full details of all sales made 
 
46. Create a query that shows SaleID, DateOfSale, Amount, EmployeeID, FirstName, LastName, and 

BranchID for all sales.  Sort by DateOfSale and then LastName.   
 

HINT: For future use in a later query, select the EmployeeID column from the Employees table and NOT 

from the Sales table .If the EmployeeID is chosen from the Sales table, the grouping requested in Item 
80, Figure 81 cannot be performed correctly. Once complete, compare your results with Figure A-54 
below and save your query as SelectSales. 

 

 
Figure A-54: Results for query SelectSales (show 7 fields, 15 records, values for SaleID may vary) 

 
 

A.4.2. SelectDateHired 
 

Query - SelectDateHired: At the end of 2020, which employees will have been with the company for 
10 years or more? 
 
47. Create a query that shows EmployeeID, FirstName, LastName, BranchID, and DateHired for employees 

that were hired on or before 12/31/2010. 
 

48. Sort the results ascending by DateHired. The employee hired first should be at the top of your results.  
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NOTE: When referencing dates in criteria, you need to surround the date with hash tags. Example: 
#3/17/1989# - keep in mind that this is NOT the same date you need to use in this query.   
HINT: For help with criteria please refer to Section A.3.2. 

Compare your results with Figure A-55 and save your query as SelectDateHired. 

 

 

Figure A-55: Results of query SelectDateHired (show 5 fields, 8 records) 
 
 
 

A.4.3. SelectCharlotteSales 
 

Query - SelectCharlotteSales: What sales were made by employees from the Charlotte branch on 
April 2, 2021? 
 
49. Create a query that shows SaleID, Amount, EmployeeID, and LastName for any sales that were made 

on 4/2/2021 AND by employees from branch CHANC. 
 

50. You need to put criteria restrictions on DateOfSale AND BranchID but you DO NOT want to show these 
columns. Uncheck the Show option to restrict without displaying in the output of the query.  
 
NOTE: Remember to put the criteria entries in the same column as the field you wish to restrict. For 
Example, you will want to put =#4/2/2021# underneath the DateOfSale field. When you want multiple 
restrictions to be required, you will place the criteria on the SAME row (Criteria) in your Design View. If 
you wanted one criteria OR the other, you would place the criteria on SEPARATE rows (one on Criteria, 
and one on the OR line). 
  
Compare your results with Figure A-56 and save your query as SelectCharlotteSales 
 

 

Figure A-56: Results of query SelectCharlotteSales(show 4 fields, 2 records, values for SaleID may 
vary) 
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A.4.4. CalcFieldBonus 
 
Query - CalcFieldBonus: Management of the Raleigh branch is going to give a 5% bonus on 
sales. What is the bonus for each sale at the Raleigh branch? 

 
Create a query that shows SaleID, Amount, Bonus, and EmployeeID for any sales that were made at the 
Raleigh branch. Bonus will be a calculated field that calculates 5% (0.05) of the Amount.  
 
HINTS: Refer to Section A.3.3 to help you with a calculated field and currency; remember field names in 
calculations must be in [ ] but values such as .05 should not be placed in brackets [ ]. You will have one 
‘hidden’ field in this query. 

51.  
NOTE: Don’t forget to format the Bonus calculated field to currency. In addition, you should rename the 
calculated field to read Bonus when the query is executed. 
 
 
Compare your results with Figure A-57 below and save your query as CalcFieldBonus. 

 

 

 
Figure A-57: Results of query CalcFieldBonus (shows 4 fields, 4 records, values for SaleID may vary) 
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A.4.5. CalcFieldNewBasePay 
 

Query - CalcFieldNewBasePay: All employees will receive an increase of $115 on their weekly base 
pay. What will the new weekly base pay be for each employee? 
 
52. Create a query that shows EmployeeID, BranchID, FirstName, LastName, and NewWeeklyBasePay. 

NewWeeklyBasePay will be a calculated field that increases the current BaseWeeklyPay by 115. 
 

53. Sort the results ascending by BranchID.   
 
HINT: you will want to add 115 to their current base pay. 
 

Compare your results with Figure A-58 and save your query as CalcFieldNewBasePay. 

 
 
Figure A-58: Results of query CalcFieldNewBasePay (shows 5 fields, 20 records) 
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A.4.6. CountNumberEmployees 
 

Query - CountNumberEmployees: How many employees do we have? 
 
54. Create a query that shows NumberOfEmployees. You will need to Count the EmployeeID within the 

Employees table.  
 
HINT: Refer to Section A/3.4 to help you find the ∑, which will assist you to COUNT the # of employees. 
 
NOTE: This will require only ONE field and there will be ONE row in output. Don’t forget to rename the 
field to NumberOfEmployees. 
 

Compare your results with Figure A-59 and save your query as CountNumberEmployees. 

 

 

Figure A-59 Results of query CountNumberEmployees (show 1 field, 1 record) 
 

 

A.4.7. AverageBasePay 
 

Query - AverageBasePay: What is the average weekly base pay of all employees at the Wilmington 
branch? 
 
55. Create a query that shows AverageBasePay for employees at the WILNC branch.  

 
HINT: You will also need to use the ∑ icon in this query. 
 
NOTE: This will require TWO fields in your Design View, but only ONE will show in the results. Your 
output will have ONE row and ONE column in it. Don’t forget to rename the field to AverageBasePay and 
format to currency. 
 

Compare your results with Figure A-60 below and save your query as AverageBasePay. 

 
 
Figure A-60: Results of query AverageBasePay (shows 1 field, 1 record) 

 

A.4.8. TotalSalesByEmployee 
 
Query – TotalSalesByEmployee: What are the total sales for each employee? 
 
56. Create a query that shows EmployeeID, LastName, FirstName, and TotalSales for each employee. You 

will need to group the employees and add the Amount of each sales record in the database. 
 

57. Sort the results alphabetical by last name and first name.  
 

HINT: Again you will need to use the ∑ icon in this query 
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Compare your results with Figure A-61 and save your query as TotalSalesByEmployee. 

 

 

Figure A-61: Results for query TotalSalesByEmployee (shows 4 fields, 12 records) 
 

A.4.9. ParameterEmployeeLookup 
 
Query - ParameterEmployeeLookup: What are the details of the employee for a specific Employee # 
 
58. Create a query that shows EmployeeID, FirstName, LastName, DateHired, BranchID, BaseWeeklyPay, 

and CommissionPercent for a specific employee. You will need to prompt the user for the EmployeeID to 
use when showing details. This will require a parameter query. 

 
HINT: See Section A.3.5 for help building a Parameter in a Query. 
 
NOTES: Your output should be only ONE record! Remember that you cannot use existing field names as 
a parameter. Your message to the user should read “What EmployeeID?” Also this should be ONE query 
– not two separate queries 
 
Compare your results with Figure A-62 when given Employee ID 2020 and Figure A-63 below when 
given Employee ID 9799. Save your query as ParameterEmployeeLookup.  
 

 
 
Figure A-62: Results for query ParameterEmployeeLookup (when given 2020 as parameter value) 
(show 7 fields, 1 record) 
 

 
 
Figure A-63: Results for query ParameterEmployeeLookup (when given 9799 as parameter value) 
(show 7 fields, 1 record) 
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A.5.0  Input Forms 

 
So far, the only method for data entry has been via the Datasheet View of each table. Some users, 
especially those without database experience, however, may not understand the concept of tables or the 
Datasheet View method of data entry. In this section, we introduce Forms to provide an easier and more 
intuitive way to input data into tables in your database. 
 
Once you have your table design and relationships set up, forms are relatively easy to create. Access has 
great built-in tools for creating forms literally “with the click of a button.” This is only useful IF you have a 
good table design and have set up the proper relationships based on common fields within your tables. 
 
 

A.5.1  BranchEmployees 

 
59. Every form must be based on a table because the form needs to know where to store the data. To create 

a form, look on the left side of your Access window for the object panel, then highlight (click) the table on 
which you wish to base your form. Once highlighted, choose the Create menu ribbon and click the Form 
icon in the Forms section (Figure A-64). Note that for forms, we WILL NOT use the Design View. 

 
 

 
 

Figure A-64: With a table highlighted, create a form by clicking the Form icon in the Create menu 
ribbon 

 
Once you click FORM, ACCESS will create an INPUT FORM for the USER.  Since you have created a 
relationship between the tables Branches and Employees, the sub-form will be created automatically for 
you. This sub-form allows managing employee records directly from the Branches form. This can be very 
useful. 
 
For forms, you should become familiar with two views: Layout View and Form View. Currently you 
should be viewing your form in Layout View. Layout View allows you to easily alter the form appearance 
by dragging and dropping elements. 
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Figure A-65: Form created from table Branches (save the form as BranchEmployees) 

 
60. Switch to Form View by right clicking the Branches tab above the form and choosing Form View.  

 
Form View allows you to actually USE the form. This view allows data entry directly into the tables 
through the form. 
 
Notice that the form created shows several things: 
- The fields contained in the table Branches (Branch ID, City, and State). Arrow #1 in Figure A-66. 
- A sub-form with Employee details for all employees at this branch. Arrow #2 in Figure A-66. 
- A panel for moving through the records that are displayed. Arrow #3 in Figure A-66. 
 

 
Figure A-66: Important sections of the form BranchEmployees 
 
To move between records in the table Branches, use the bottom panel. The arrows move forward and 

back through branch records. There is also an icon to create a new record  and ability to search for 
content within the existing records. 
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61. Save the form as BranchEmployees. 
 
 

A.5.2  EmployeeSales 

 
 
62. Create a second form based on the existing fields and relationships for the table Employees. Your form 

should look like Figure A-67 
 
Notice that this form includes a sub-form for the sales records that exist for each employee. Like for the 
form BranchEmployees, this sub-form exists because of the relationships that you created earlier. 

 
63. Save the current form as EmployeeSales. 

 

 

  
Figure A-67: Form EmployeeSales 
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A.6.0  Reports 

 
If you want to create formatted output instead of the “spreadsheet style” output that you get from queries, you 
should build a report. Reports allow formatting data in a much more readable and attractive manner, and can 
be passed out to stakeholders, management, or team members for review and decision making. Some 
people find it difficult to extract data from query output, so reports can provide an easier way to understand 
data quickly. This can be a great benefit within an organization. 
 
Reports should be based on a query in your database. When you run a report, the query is first executed 
behind the scenes and the records that result from the query’s execution are then used to generate the 
report. Access applies the formatting specifications that you defined in your report layout. Besides the fields 
defined in the underlying query, you can display additional totals and groupings in the report. 
 

A.6.1  Sales by Branch 

 
64. To create a report, you begin by highlighting the query in the object panel to the left of your Access 

window on which you wish to base your report. Once highlighted, choose the Create menu ribbon and 
click the REPORT. (Figure A-68) Note that for reports you WILL NOT use the Design View. 

 

 
 
Figure A-68: With a query highlighted (from the objects panel), create a report by clicking the 
Report icon in the Create menu ribbon 
 
Create a new report based on the query SelectSales that was created previously in Section A.4.1. To 
start the report, highlight the query SelectSales and click the Report button in the Reports section of the 
Create menu ribbon. Your report will appear in Layout View and should look like Figure A-69. (For now, 
ignore the Group & Sorting panel if it appears at the bottom of your screen.) 
 

 
 
Figure A-69: Initial Layout View for Report SalesByBranch, created from query SelectSales  

 
 

65. First, notice the gray dotted lines around Layout View. These are the designated page margins. If you 
were to print this report right now, parts of it would be cut off. In order to fit the contents to one page, you 
need to resize some columns. To resize a column, click the field title you wish to resize. Once 
highlighted, move your mouse to the left or right side of the highlighted box. When your cursor turns to a 
double sided arrow, click and drag to change the width of a column. You could also use the same 
process to change row height of the report. 
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66. Resize FirstName and LastName so that the full contents of the report fit within the page margins. Your 
report Layout View should resemble Figure A-70. 

 
Figure A-70: Layout View for Report SalesByBranch after resizing column widths 

NOTE: When making changes, remember you can use the UNDO option. The Undo icon  is located 
near the Save icon in the extreme top left of your Access window. Also, you can use Ctrl+Z to activate 
an UNDO. 

 
67. Next, notice the date and time that are printed in the top right to indicate when the report was generated. 

In addition, a title is created on the top left. By default, the title of the report is the same as the name of 
the query on which the report is based. To change the title, double-click the existing title in Layout View 
and edit the text. 

 
Change the title of the report to be Sales by Branch. Your title should now match Figure A-71. 

 

 
Figure A-71: Layout View for Report SalesByBranch after changing the title 

 
68. While in Layout View, you can also rearrange fields or remove fields. Before you perform either of these 

actions, select the entire column you wish to manipulate. To select an entire column, click within the 
column and select the Arrange menu ribbon on top of your screen. Click the Select Column button in the 
Rows & Columns section of the Arrange menu ribbon (Figure A-72). 
 

  
 
Figure A-72: Highlight an entire column by selecting the Select Column icon in the Rows & 
Columns section of the Arrange menu ribbon. 
 
To delete a column once highlighted, hit the delete key on your keyboard. You may also right click the 
highlighted column and choose Delete Column. 
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To move a column once highlighted, click and hold on the column and drag the column left or right. The 
cursor will show a notification of where the column will be placed. Release the mouse button to move the 
column to the selected location. 
 

69. Rearrange the fields of the report so that they appear in this order: BranchID, DateOfSale, EmployeeID, 
LastName, FirstName, SaleID, and then Amount. After rearranging the fields, your report Layout View 
should look like Figure A-73. 

 

 
Figure A-73: Layout View for Report SalesByBranch after rearranging fields 

 
70. Before moving on to make some additional changes, make sure that all contents of the report are within 

the page margins. If they are not, click to highlight each object and resize or move it into the page 
boundaries. Also make sure the contents of all rows can be seen. If they cannot, resize their height 
accordingly. For example, take note of the bottom of the report. Page 1 of 1 is displayed but it may be 
outside of the page margins. Anything outside the gray dotted line should be moved inside the margins. 
Also, there is an automated total at the bottom of the amount column. Notice how the contents of this 
field cannot be fully seen, so the height of this field has to be changed. 
 

71. Save the report as SalesByBranch. 
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A.6.2  Report Grouping and Totaling 

 
For this report, we want to highlight the sales for each individual branch. In addition, we want to total the 
sales for each branch and display the totals on the report. All of these additions to the query can be done 
in report Layout View. 

 
72. One of the great additions you can apply with reports is grouping and sorting. Click the Design option in 

the menu tool bar and then Group and Sort (Figures A-74 and A-75). 
 

 
 
Figure A-74: Selecting Design and then Group and Sort 
 

 
Figure A-75: Options once you select Group and Sort 
 

73. When you click Add a group or Add a sort, you will be asked to choose a field. Grouping will pull all 
records with the same value for the selected field and display them together in the report. Sorting will 
reorder the records based on the values of the selected field. 

 
74. Group this report by BranchID and sort the records by DateOfSale. After adding a group and a sort, the 

Layout View of your report should look like Figure A-76. 
 

 
 
Figure A-76: Layout View for Report SalesByBranch after adding a group and a sort 
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75. When a report has a grouping, you may wish to add up the values from a certain column, count the 
records within a group, or perform other functions. To do so, select the column (Amount), then click the 
Totals icon in the Grouping & Totals section in the Design menu ribbon and finally SUM. Refer to Figure 
A-77  
 

 
 
Figure A-77: Totals options within report Layout View 

 
76. Resize the height for the total so that the entire content is displayed. Your Layout View should look like 

Figure A-78.  
 

 
Figure A-78: Layout View for Report SalesByBranch after adding a total to Amount 

 
77. Make sure to save the report often. 
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6 A.3  SalesByEmployee 

 
Generate a second report based on the query SelectSales. For this report we will use the Report Wizard 
option to help us with sorting and totaling. 

 
78. Click the CREATE and then the REPORT WIZARD in the Toolbar, you will then be presented to select 

the query (SelectSales) and which fields you desire to display.  See Figure A-79. 
 

 

Figure A-79: Using the Report Wizard option to build a Report. 
 
79. To save the effort of rearranging columns, select the columns in the following order (one by one) and 

then hit the right arrow to move them to the Selected Fields box in this order 
a. EmployeeID, FirstName, LastName, BranchID, Amount, DateOfSale  
b. Once complete your Selected Fields should look like Figure A-80 
c. Finally click Next 

 

 
 
Figure A-80: Selected fields in order of display. 
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80. The Report Wizard will provide a guess at the grouping you desire, see Figure A-81. Accept the view 
options it has provided (by Employees). Click Next.  Note: if you do not see EmployeeID in the top row, 
the error is generally caused by an error in the SelectSales Query. Return to that query and in design 
view, ensure that the EmployeeID column is coming from the Employee Table and not the Sales Table. 

 
 

Figure A-81: Report Wizard Option: How to View Your Data 
 
81. The third wizard screen will ask for any additional grouping, accept the default. 
 
82. The fourth wizard screen will ask for Sorting and Summary Options, select DateOfSale for the sort and 

then click the Summary Options. Figure A-82. 

 
 
Figure A-82: Report Wizard Option: Sorting and Summary Options 
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83. Finally, we want to have the Amount field to be summed for us. The Detail & Summary will provide a 

subtotal for each employee, while if you selected the Summary Only option you would only get a Grand 
Total at the bottom of the report. Select the SUM option for the Amount field and the Detail and Summary 
Option. Figure A-83. Once you have the options below click OK and then Next. 

 
 

Figure A-83: Report Wizard Option: Sum and Total Options 
 
84. Accept the default layout (Figure A-84). 

 
 
Figure A-84: Report Wizard Option: Layout 

 
85. The final option is to provide a report heading and then move to modifying the design. See Figure A-85. 
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Figure A-85: Report Wizard Option: Layout 
 

 
86. A report will be generated for you to modify. As can be seen in Figure A-86, columns widths will need to 

be adjusted to make the report readable. 
 

 
 
Figure A-86: Report before modifying column widths 
 
 

87. Make sure you are in Layout Mode (top left). Carefully move the FirstName and Kim to the right  
 
HINT: To select them both at the same time, hold the control key down while clicking on FirstName and 
Kim. 
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88. Slowly move all the other columns to the left. 
 
89. If you get the #’s signs as shown in Figure A-87, you will need to expand the size(width) of the Amount 

Column.  In Design or Layout view, click on the Amount Box and widen. If done property you will look like 
Figure A-88.   Also delete the ‘Summary for ‘EmployeeID’ box. 

 

 
 
Figure A-87 Report after modifying column widths 
 
 

90. Modify the column headings by clicking on each one and modifying as shown in Figure A-88. 
 

 
 
Figure A-88 Report after modifying column headings. 

 

 
Figure A-89 Finished bottom of the report with Grand Total 
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91. Save your report 
 
92. Rename the report (only the object name, not the report heading) to SalesByEmployee 
 

A.6.4  Additional Formatting for Reports 

 
The following steps may be optional, please check with your instructor if these steps are required or 

optional. Jump ahead to step A.6.5 if you are not required to do the additional formatting. 
 
Usually you will want to modify the formatting of a report. This could be as simple as bolding a particular 
field, changing the fonts, or modifying the borders. Each column has its own set of formatting in a report. 
Similar to what we did so far, you can make formatting changes in the Layout View of the report. 
 
93. Reopen the SalesByBranch Report  

 
94. The most common formatting options are available in the Format menu ribbon (Figure A-90). You can 

modify Font attributes, Borders, Backgrounds, and Number Formatting. 
 

 
 
Figure A-90: Formatting options for reports are located in the Format menu ribbon 

 
95. Change the columns headings to make them more used friendly. Change the Headings to Read: Branch 

ID, Date of Sale, Employee ID, etc. Notice the space in the headings. In addition, revise the headings to 
be bolded and in italics (see Figure A-92). 
 

96. Remove the alternating gray backround. In Layout View, highlight all columns (but not the headings), 
this will highlight all cells in the detail rows in yellow. Once you highlight all the rows, right click on 
Properties and then select the Detail view from the Top Drop Down List. Finally find the Alternate Back 
Color Property and change the property value to Background 1 (eliminating the 5% darker). See Figure 
A-91. 
 

97. Do the same for Group Footer 1 (from the top Drop Down List) 

 
 
Figure A-91: Eliminating the alternating gray backgrounds 
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98. Getting familiar with these controls should be intuitive but it may take some time to get the desired 

results. Remember that you can always use the Undo icon and you should save your report often!  Your 
final result should look like Figure A-92. 

 

 
 
Figure A-92. Formatted SalesByBranch Report 

 

A.7.0  Uploading your file to Entropy for Grading and to One Drive 

 
 
1. Make sure your database is closed. Access should not be open when you upload it to Entropy. 

 
2. Open a web browser. 

 
3. Go to Entropy (https://csbapp.uncw.edu/Entropy/). Enter your Entropy UserID and Password and select 

the appropriate class. 
 

https://csbapp.uncw.edu/Entropy/
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4. Click the Upload Assignment option. 

 
 
Figure 12: Entropy, starting the process to upload an assignment 
 
 

5. Find the correct assignment you wish to upload. The name may vary based on your instructor. Your file 
will most likely be in your OneDrive Cloud Storage Area.. 

 
6. Click Upload Now beside the appropriate assignment. 

 

 
 
Figure 12: Entropy, upload an assignment 
 

7. Entropy will respond with a listing of all files uploaded and their date/time. If you upload a file for the 
same assignment more than once, you will see both uploads listed but only the most recent 
upload will be kept and graded. 

 

 
 
Figure 13: Summary of files uploaded 
 

NOTES: You should check your file size: If it is small (under 500KB or zero), there’s a good chance that you 
either left the database open when you attempted to upload it or you uploaded a shortcut link to your 
database.. Make sure that you have closed the file and then attempt your upload again. 

 
 


